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Введение 

В настоящем пособии приведены методические указания к 

выполнению лабораторных работ по курсу «Городская информатика и 

геоинформатика». 

По итогам выполнения каждой лабораторной работы студенту 

необходимо подготовить отчет, отражающий основные результаты работы. 

Отчет должен содержать следующие обязательные части: 

1) Цель работы – описание основных навыков и компетенций, 

которые студент должен был приобрести либо развить в ходе 

выполнения лабораторной работы; 

2) Ход выполнения – описание основных действий студента, с 

кратким пояснением и сопроводительной иллюстрацией (в 

разделе «Содержание отчета» представлены комментарии для 

каждой лабораторной работы); 

3) Выводы – резюме полученных результатов. 

Отчет о выполнении лабораторной работы должен быть оформлен 

согласно требованиям ГОСТ и включать титульный лист и основную 

часть. Образец титульного листа представлен в Приложении 1. 

Обязательным элементом сдачи отчета является защита 

лабораторной работы, в рамках которой студент отвечает на вопросы из 

контрольного списка. 
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Лабораторная работа № 1 

Создание базовой карты в QGIS Desktop 

ЦЕЛЬ РАБОТЫ 

В данной работе студенты узнают основные функции 

географических информационных систем, получат базовые навыки работы 

с географической информационной системой на примере QGIS Desktop. 

Знакомство с основными элементами интерфейса QGIS Desktop: 

— добавление слоев; 

— настройка стилей; 

— установка плагинов; 

— экспорт результата. 

ОБОРУДОВАНИЕ И ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ 

Для выполнения лабораторной работы требуется: 

— браузер с доступом к сети Интернет; 

— QGIS Desktop 2.16 и выше. 

КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Картография – это область науки, включающая в себя 

исследование, создание и использование карт. 

Карта – это уменьшенное, обобщенное изображение поверхности 

Земли, другого небесного тела, либо некоторого его участка, построенное 

в определенной картографической проекции, показывающее 

расположенные в пространстве объекты.  

Геоинформационные системы (ГИС) предназначены в первую 

очередь для анализа и визуального представления пространственных 

данных с географической привязкой. Некоторые системы обладают также 

соответствующей функциональностью для сбора и хранения данных. ГИС 

успешно применяются в качестве систем поддержки принятия решений в 

различных сферах жизни города, таких как здравоохранение, транспорт, 

городское планирование, а также для решения геоэкологических задач.  

Эффективность использования геоинформационных систем 

обусловливается визуальным представлением информации в виде карт и 

возможностями ее анализа. Разные наборы данных могут быть размещены 

на отдельных слоях, а дополнительный сопоставительный анализ может 

привести к получению новых знаний. Данные в ГИС делятся на 

дискретные и непрерывные и представляются либо в векторном, либо в 

растровом виде. 
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Векторные данные могут быть представлены на карте точкой, 

линией или полигоном. В векторном виде обычно представляют 

транспортные маршруты, территориальные границы, дома. 

Растровые данные представляют собой матрицу, каждый элемент 

которой соответствует пикселу и содержит некоторое числовое значение. 

Чаще используются для представления непрерывных данных, таких как 

рельеф, погодные характеристики и пр. 

QGIS Desktop – это кроссплатформенная геоинформационная 

система, предназначенная для пространственного анализа и создания карт. 

Распространяется свободно под лицензией GNU GPL 2. Графический 

интерфейс приложения включает в себя множество инструментов для 

исследования пространственных данных. QGIS позволяет преобразовывать 

данные и экспортировать их в различных форматах. 

Одним из популярных векторных форматов географических данных 

является так называемый «шейп-файл» (Shapefile). Данный формат 

позволяет хранить различные векторные объекты (точки, полигоны, и т.д.), 

однако отдельный файл может содержать объекты только одного 

заданного типа. Каждая запись может иметь несколько атрибутов для 

описания. 

ХОД РАБОТЫ 

Создание нового проекта. Для начала работы запустите 

приложение QGIS Desktop. Для создания нового проекта откройте в 

основном меню вкладку Project → New или воспользуйтесь комбинацией 

клавиш Ctrl + N. 

Импорт данных в QGIS. После распаковки исходных данных 

(архив «Lab 1 - Materials.zip») в папке будет находиться несколько файлов, 

отвечающих реальным данным: дороги, здания и пр. Для того чтобы 

добавить файлы в проект, достаточно «перетащить» файл с данными 

route.geojson на панель слоев. Кроме того, файл может быть добавлен с 

помощью панели добавления слоев (рис. 1.1). Для добавления слоя 

нажмите на кнопку «Add Vector Layer» и укажите путь к папке с вашими 

файлами. 
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Рисунок 1.1 – Интерфейс QGIS Desktop,  

красным цветом выделена панель добавления слоев 

Создание нового поля в данных. Для создания нового поля 

воспользуйтесь окном атрибутов данных – кнопка Open Attribute Table. 

Активируйте режим редактирования с помощью кнопки Edit и откройте 

калькулятор полей. Создадим новое поле, которое будет отвечать за 

порядок соединения наших точек – в качестве такого поля в данном может 

выступать номер строк (переменная row_number). Выберите данную 

переменную (Рисунок 1.2) и нажмите «Ok». Убедитесь, что в таблице 

атрибутов появились новые данные. 

 
Рисунок 1.2 – создание нового поля 

Создание нового слоя. Откройте окно инструментов Toolbox (View 

-> Panels -> Toolbox) – все дополнительные инструменты находятся в этой 
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вкладке. Если в дальнейших работах необходимый инструмент отсутствует 

в основном меню, воспользуйтесь поиском в панели Toolbox. 

В списке инструментов найдите функцию Points to path, выберите 

route.geojson в качестве входных данных. Установите группировку по 

полю OfficialGuide и порядок соединения по только что созданном вами 

полю. В результате будет создан временный слой из линий, сохраните его, 

кликнув правой кнопкой мыши по слою Paths в панели слоев (Рисунок 1.3). 

Выберите формат GeoJson, выберите директорию, введите название файла 

и нажмите «Ok». Теперь временный слой можно удалить. Настало время 

настроить отображение получившегося маршрута. 

 
Рисунок 1.3 – панель слоев (слева) и панель инструментов Toolbox (в 

правой части экрана) 

Стилизация карты. Для изменения стандартных цветов 

необходимо выделить слой в панели слоев. Для отключения отображения 

слоя необходимо снять отметку в поле рядом с названием слоя.  

Окно Свойства слоя открывается через вспомогательное меню 

(отображается по клику правой кнопки мыши по названию слоя), либо с 

помощью двойного клика по названию слоя. 

Выберите пункт Style в левом меню. Изменяя такие параметры, как 

цвет, толщина границы и прозрачность, можно настроить отображение 

слоя по своему усмотрению. Для более детальной настройки 

воспользуйтесь пунктом Simple fill (рис. 1.4). 
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Рисунок 1.4 – Окно настройки стиля слоя 

Добавление картографического слоя. Иногда экспортируемых 

данных недостаточно для создания полноценной карты. В таком случае 

средствами QGIS Desktop может быть импортирован слой с 

картографической подложкой напрямую из OSM или Google. 

Для добавления слоя необходимо выполнить следующие действия. 

1. Убедитесь, что плагин OpenLayers установлен, в противном 

случае установите его, следуя инструкции ниже. 

2. Перейдите в меню Web → OpenLayers → Название подложки. 

Слой с картой добавится на верхний уровень. Перетаскивайте слои 

для изменения их порядка. 

Установка плагинов в QGIS Desktop. Установка плагина 

осуществляется следующим образом. 

1. Убедитесь, что QGIS разрешен доступ в Интернет. Для 

успешной установки плагинов из рабочей сети Университета 

ИТМО необходимо прописать настройки прокси-сервера во 

вкладке Networks. 

2. Перейдите в меню Plugins → Manage and Install Plugins. 

3. В строке поиска наберите имя требующегося плагина. 

4. Нажмите кнопку «Install». 

Экспорт изображения. QGIS Desktop позволяет экспортировать 

результаты в качестве изображений в различных форматах (PNG, BMP, 

JPG, TIFF и т.д.). Сохраните полученный результат в одном из 

вышеперечисленных форматов (рис. 1.5). 
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Рисунок 1.5 – Пример результата 

СОДЕРЖАНИЕ ОТЧЕТА 

Отчет должен быть подготовлен в соответствии с шаблоном 

(Приложение 1) и содержать скриншоты экрана: после импорта данных в 

QGIS, после настройки стилей, подгруженный картографический слой из 

внешнего источника. 

ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 

1. Что такое карта? 

2. Что изучает наука картография? 

3. Какие способы представления данных вы знаете? 

4. Что такое геоинформационная система? 

5. Для чего применяются геоинформационные системы? 

ЛИТЕРАТУРА 

1. Брынь М. Я., Богомолова Е. С., Коугия В. А., Левин Б. А. 
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2. Берлянт А. М. Картография: Учебник для вузов. М.: Аспект 

Пресс, 2002. С. 5–36. 
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https://docs.qgis.org/2.2/en/docs/training_manual.  

4. OpenStreetMap, http://www.openstreetmap.org/about. 
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https://docs.qgis.org/2.2/en/docs/training_manual/
http://www.openstreetmap.org/about
http://extract.bbbike.org/
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Лабораторная работа № 2 

Картографические проекции 

ЦЕЛЬ РАБОТЫ 

В ходе данной работы студенты получат знания о системах 

географических координат, научатся преобразовывать системы координат. 

— Получение представления о датуме и картографических 

проекциях; 

— Знакомство с проекциями в QGIS Desktop: 

o смена проекции проекта; 

o настройка проекции слоя; 

o создание собственной проекции. 

ОБОРУДОВАНИЕ И ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ 

Для выполнения данной лабораторной работы требуется QGIS 

Desktop 2.16 и выше. 

КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Используя определение из предыдущей работы, можно выделить 

три основных особенности карт:  

— математически определенное построение; 

— использование условных знаков; 

— обобщение пространственных данных и явлений.  

Как известно, поверхность Земли имеет не идеальную форму. 

Изучение земной поверхности является задачей, в том числе и 

математической картографии. 

Геоид – это выпуклая замкнутая поверхность, ограниченная 

уровенной поверхностью мирового океана. Первое определение геоида 

было введено в 1873 г. немецким физиком Листингом. 

Референц-эллипсоид – геометрически правильная фигура, 

наилучшим образом приближенная к соответствующему геоиду. 

Датум (от англ. Datum – данная величина, исходный уровень) – 

набор параметров, применяющийся для перевода данных (проекции) 

референц-эллипсоида в некоторую систему координат. Датум задается 

через смещение референц-эллипсоида по трем осям, а также поворот 

декартовой системы координат в плоскости осей на угол. 

В математической картографии применяются различные виды 

систем координат: пространственные прямоугольные, криволинейные, 

полярные и т.д. 
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Геодезическая система координат применительно к трехосному 

эллипсоиду определяется неоднозначно. Поэтому выбираются опорные 

пункты – точки, полученные в системе геодезических координат, 

принятых в данном государстве, и координатные сетки, учитывающие 

некоторые опорные пункты. На территории Российской Федерации 

используется эллипсоид Красовского с начальным опорным пунктом – 

Пулково. 

ХОД РАБОТЫ 

Запуск существующего проекта. Для открытия ранее созданного 

проекта запустите QGIS Desktop через основное меню Project → Open 

World View.qgs (рис. 2.1). Открыть проект можно также по двойному 

клику на его файле (*.qgs), однако при этом (даже если уже запущено 

приложение без открытого проекта) запустится новый экземпляр 

программы.  

Если проекция не задана пользователем, в качестве основной будет 

установлена равнопромежуточная проекция. Файл проекта содержит два 

слоя с полигонами Circles и Land, слой с точками Cities, а также сетку из 

линий Graticule. Если бы слой Circles отображался на глобусе, 

изображение представляло собой идеальные круги. Однако на 

изображении можно наблюдать искажения, вызванные проекцией. 

Приложение использует параметры долготы и широты для измерений в 

геодезических десятичных градусах, которые отображаются как простая 

прямоугольная сетка, в которой один градус долготы всегда равен одному 

градусы широты. Использование проекций, которые сохраняют форму, 

позволит отобразить полигоны слоя Circles как круги. 

 

 
Рисунок 2.1 – Слои проекта World View.qgs 
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Измерение расстояний. Для просмотра меню систем координат 

проекта в основном меню выберите Project | Project Properties. Затем 

перейдите в раздел CRS для просмотра текущей системы координат 

(Coordinate Reference System). Нажмите Cancel для того, чтобы закрыть 

окно. 

Теперь необходимо измерить расстояние в текущей проекции для 

последующего сравнения. Выберите инструмент измерения (Measure Line 

tool)  на панели атрибутов. Откроется специальное окно.  

Кликните на точку Atlanta (Атланта, США). Переместите курсор к 

точке Alice Springs (Элис Спрингс, Австралия), затем используйте правую 

кнопку мыши для завершения линии. Результат (рис. 2.2) – расстояние 

между Атлантой и Элис Спрингс будет показано в окне измерений 

(Measure box). 

 
Рисунок 2.2 – Измерение расстояния 

Смена системы координат проекта. В основном меню выберите 

пункт Project → Project Properties. Перейдите во вкладку CRS. Убедитесь, 

что активна опция: Enable ‘on the fly’ CRS transformation (рис. 2.3). Далее 

выберите проекцию WGS 84 / Pseudo Mercator из списка проекций 

(Coordinate Reference Systems). 
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Рисунок 2.3 – Окно свойств проекции 

Если до этого момента окно измерений не было закрыто, 

расстояние между городами обновится автоматически. В противном 

случае повторите шаги из предыдущего пункта. 

 
Рисунок 2.4 – Проекция Меркатора  

Обратите внимание! В дальнейшем если не указано обратное все 

карты готовятся в проекции WGS 84 / Pseudo Mercator. 
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Мировые проекции. В данной части работы студентами 

исследуются картографические проекции, предназначенные для 

отображения всего земного шара – проекции Эккерта (Eckert projection). В 

проекциях, содержащих в названии нечетное число, параллели размещены 

равномерно. В четных проекциях меридианы расположены на равном 

расстоянии. Три пары проекции различаются заданием формы меридианов: 

в Эккерт I и Эккерт II меридианы представляют собой прямые линии, 

пересекающие экватор под углом; в Эккерт III и Эккерт IV используются 

эллиптические меридианы; в Эккерт V и Эккерт VI меридианы 

синусоидальные. 

Для смены проекции откройте вкладку CRS в окне свойств проекта. 

Наберите «Eckert» в строке фильтра; с использованием строки поиска 

можно легко найти необходимую проекцию. Выберите любую проекцию 

Эккерта из фильтрованного списка. Для применения выбранной проекции 

и переключения к окну карты воспользуйтесь кнопкой «OK». Результат 

работы алгоритма преобразования проекции для системы Эккерт V 

представлен на рис. 2.5. Используя инструмент измерения расстояний, 

вычислите дистанцию между Атлантой и Элис Спрингс. 

Обратите внимание! В случае ошибки рендеринга карта может 

выглядеть неправильно – состоять из блоков. Для того чтобы избавиться от 

этого эффекта, воспользуйтесь функцией масштабирования или смените 

проекцию. 

 

 
Рисунок 2.5 – Картографическая проекция Эккерт V 

Национальные картографические проекции. Проекции, 

использующиеся для отображения планеты целиком, не всегда 

оптимальны для картирования меньших областей, таких как континенты 

или страны. При создании карты в средних широтах важно использовать 
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проекцию, которая центрируется на отображаемой области и имеет 

прямую линию или линии, проходящие через отображаемую область. 

Экспорт векторных данных. Для решения городских задач 

зачастую необходимо обладать базовой информацией о расположении 

домов, границ территорий, дорог и пр. Наиболее распространенным 

источником географических данных является сервис OpenStreetMap 

(OSM). Существует несколько способов получения данных из OSM: 

— экспортировать данные напрямую; 

— использовать готовые наборы данных, например, MapZen1; 

— использовать сервисы с настраиваемой областью выгрузки: 

Trimble2, BBBike; 

— использовать встроенный плагин в QGIS. 

Trimble. Для изучения проекций на локальном и местном уровне 

воспользуемся сервисом Trimble, который позволяет бесплатно выгружать 

определенные данные из OSM в заданном формате. Перейдите на главную 

страницу сервиса (https://data.trimble.com/market/index.html) и выберите 

раздел границы (boundaries), в списке предложенных источников выберите 

OpenStreetMap: Worldwide Boundaries. Введите в поисковой строке 

название города и выберите в списке слоев только границы. Отрисуйте 

желаемую область примерно так, как показано на рисунке 2.6, выберите 

формат данных ESRI Shapefile и добавьте в корзину. Завершите 

оформление заказа и выгрузите данные на компьютер. 

 
Рисунок 2.6 – Интерфейс Trimble  

                                           

1 https://mapzen.com/data/metro-extracts/ 
2 http://data.trimble.com/market/index.html 

https://data.trimble.com/market/index.html
https://mapzen.com/data/metro-extracts/
http://data.trimble.com/market/index.html
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Откройте в QGIS Desktop проект Country View.qgs.  

Обратите внимание! Для фокусировки области отображения на 

конкретном слое щелкните правой кнопкой мыши на нем и воспользуйтесь 

опцией Zoom to Layer. 

 

Как и в предыдущих заданиях, измерьте расстояние между Санкт-

Петербургом и Нью-Йорком в километрах. 

Установите для проекта систему координат WGS 84 / Pseudo 

Mercator. Если возникнет необходимость, воспользуйтесь опцией 

фокусирования на слое Lower 48 States. Повторно рассчитайте расстояние 

между городами. 

Полученное значение будет совпадать с фактическим расстоянием – 

3962 км. Помните, что для этой проекции в QGIS координаты 

воспринимаются как широта и долгота. Расстояние рассчитывается вдоль 

большой дуги окружности, и поэтому фактическое расстояние до Земли 

сохраняется. Однако другие свойства искажены. 

Теперь получим данные, используя проекцию Эккерт IV. Эта 

проекция успешно используется для всего мира, но следует проверить, что 

происходит в рамках одной и нескольких стран в средней широте (рис. 

2.7). 

 
Рисунок 2.7 – Проекция Эккерт IV  

Создание собственной системы координат. Очевидно, что при 

использовании данной проекции возникают искажения, наиболее 

заметным из которых является сдвиг. Часть проблемы заключается в том, 

что эта проекция центрирована на 0 градусах долготы. Для того чтобы это 

исправить, создадим специальную относительную систему координат, 

основанную на мировой проекции. 

Перейдите в меню настроек Settings | Custom CRS… В данном окне 

можно создать свою систему координат. Так как полученная система 

базируется на проекции Эккерта, кликните на кнопку «Copy existing CRS 

button»  для открытия списка систем координат. Выберите 

World_Eckert_IV из перечня недавно использованных проекций (рис. 2.8). 
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Рисунок 2.8 – Окно создания собственной системы координат 

Необходимо сдвинуть центральный меридиан к –96.000 градусам 

долготы вместо 0.000. Таким образом, центр проекции окажется в 

географическом центре страны. Для этого замените нулевой меридиан 

следующим значением: 

вместо lon_0 = 0 задайте lon_0 = −96.0. 

Параметры проекции принимают следующий вид: 

+proj = eck4 + lon_0 = −96.0 + x_0 = 0 + y_0 = 0 + datum =
WGS84 + units = m + no_defs. 

В поле Name введите название проекции, например, 

USA_Eckert_IV. Это имя в дальнейшем будет использоваться в списке 

проекций. Для того чтобы использовать созданную проекцию, перейдите в 

окно проекций проекта и пролистайте до конца список Coordinate reference 

systems of the world, в конце списка будет перечень проекций, заданных 

пользователем. Выберите из данного списка свою проекцию и нажмите 

кнопку «OK». 

Подписи. Если исходные данные содержат некоторые текстовые 

поля, может быть целесообразным отобразить их на карте, например, 

подписать название городов. Для этого перейдите во вкладку Labels окна 

свойств для слоя LA & NYC (рис. 2.9). 
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Рисунок 2.9 – Окно настроек подписей 

Изменяя параметры в данном окне, можно настроить шрифты, 

толщину обводки, тип границы и многое другое. Кроме того, многие 

параметры могут быть заданы с помощью регулярных выражений 

(формул), определяющих значения на основе каких-либо характеристик 

слоя. 

Задайте размер шрифта для города в зависимости от его населения. 

Нажмите на кнопку выражений напротив параметра Size . Выберите 

пункт редактирования (Edit…) из выпадающего меню: откроется окно 

редактирования формул (рис. 2.10). 

 
Рисунок 2.10 – Окно редактирования формул 
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Для того чтобы посмотреть все поля, содержащиеся в наборе 

данных, разверните список Fields and Values. С помощью двойного клика 

по элементу списка можно автоматически добавить его в окно редактора 

регулярного выражения. Выберите поле POPULATION. 

Обратите внимание! Для того чтобы посмотреть все значения 

поля, содержащиеся в датасете, воспользуйтесь кнопкой «all unique», так 

же можно посмотреть пример данных с помощью кнопки «10 samples». 

Теперь необходимо установить корректный размер шрифта, для этого в 

нашем случае достаточно разделить значение на 1 000 000. 

 

Измените какие-нибудь другие параметры для подписей. 

Задание градиента. В дополнение к вышеперечисленному можно 

задать окраску полигона (а также точек и линий) в зависимости от 

геометрических свойств объекта. 

Измените значение Single symbol на Graduated в окне стилей. 

Установите в поле Column значение AREA. Выберите желаемую палитру, 

классифицируйте данные и примените изменения (рис. 2.11). 

  

Рисунок 2.11 – Окрашивание карты значениями по умолчанию 

Для того чтобы получить более информативный результат, 

измените количество классов, например, на 10. В дополнение можно 

изменить способ классификации на квантили Quantile (рис. 2.12). 
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Рисунок 2.12 – Окно настроек стилей 

Измените другие параметры слоя, например, контур карты. 

Сохраните получившееся изображение, пример представлен на рис. 2.13. 

 
Рисунок 2.13 – Результат стилизации слоя для США 

Фильтрация и добавление данных. В данном проекте уже 

содержится информация о площади штатов США, добавим аналогичную 

информацию для районов Санкт-Петербурга. Для начала необходимо 

отфильтровать данные из слоя полигонов. Для этого выделите слой с 

полигонами и вызовите окно выделения объектов по условию (Рисунок 

2.14), откроется окно, аналогичное окну настройки стилизации. За уровень, 

соответствующий административным районам, в данных отвечает поле 
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admin_level со значением 5. Укажите соответствующее выражение и 

нажмите кнопку «Select». После этого сохраните выделенные полигоны на 

новый слой. 

 
Рисунок 2.14 – Окно выбора объектов 

Перейдите в режим редактирования получившегося слоя, 

аналогично предыдущей лабораторной работе добавьте новое поле AREA, 

воспользовавшись встроенным калькулятором площадей Geometry -> 

$area. Затем выйдите из режима редактирования. Осуществите стилизацию 

слоя аналогично данным со штатами США (Рисунок 2.15). 

 
Рисунок 2.15 – Результат стилизации слоя для Санкт-Петербурга 
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Добавление информации в ручном режиме. В слое со штатами 

США есть поле, отвечающее за население каждого штата. Добавьте такие 

же данные, а также информацию об английском названии районов для 

Санкт-Петербурга в ручном режиме. Для этого воспользуйтесь 

информацией из Википедии на русском (Административно-

территориальное деление Санкт-Петербурга) и английском 

(Administrative_divisions_of_Saint_Petersburg) либо из официальных 

источников (http://data.gov.spb.ru/). Переведите слой в режим 

редактирование и создайте новое поле с помощью кнопки «New Field» 

(Рисунок 2.16). В таблице атрибутов выделите последовательно запись, 

соответствующую каждому району, и введите данные. Повторите данную 

процедуру для англоязычного названия районов. Выполните стилизацию 

новой карты с добавлением подписей районов. 

 
Рисунок 2.16 – Создание нового поля 

Добавление картографического слоя. В получившейся карте 

много пустого места между полигонами США и Санкт-Петербурга. 

Добавьте новый картографический слой с помощью плагина 

QuickMapServices. QuickMapServices предоставляет множество 

картографических подложек, включая CartoDB (Рисунок 2.17), 2gis, 

кадастровые данные и многие другие. 

https://ru.wikipedia.org/wiki/%D0%90%D0%B4%D0%BC%D0%B8%D0%BD%D0%B8%D1%81%D1%82%D1%80%D0%B0%D1%82%D0%B8%D0%B2%D0%BD%D0%BE-%D1%82%D0%B5%D1%80%D1%80%D0%B8%D1%82%D0%BE%D1%80%D0%B8%D0%B0%D0%BB%D1%8C%D0%BD%D0%BE%D0%B5_%D0%B4%D0%B5%D0%BB%D0%B5%D0%BD%D0%B8%D0%B5_%D0%A1%D0%B0%D0%BD%D0%BA%D1%82-%D0%9F%D0%B5%D1%82%D0%B5%D1%80%D0%B1%D1%83%D1%80%D0%B3%D0%B0
https://ru.wikipedia.org/wiki/%D0%90%D0%B4%D0%BC%D0%B8%D0%BD%D0%B8%D1%81%D1%82%D1%80%D0%B0%D1%82%D0%B8%D0%B2%D0%BD%D0%BE-%D1%82%D0%B5%D1%80%D1%80%D0%B8%D1%82%D0%BE%D1%80%D0%B8%D0%B0%D0%BB%D1%8C%D0%BD%D0%BE%D0%B5_%D0%B4%D0%B5%D0%BB%D0%B5%D0%BD%D0%B8%D0%B5_%D0%A1%D0%B0%D0%BD%D0%BA%D1%82-%D0%9F%D0%B5%D1%82%D0%B5%D1%80%D0%B1%D1%83%D1%80%D0%B3%D0%B0
https://en.wikipedia.org/wiki/Administrative_divisions_of_Saint_Petersburg
http://data.gov.spb.ru/
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Рисунок 2.17 – Пример результата стилизации карты муниципальных 

округов Санкт-Петербурга 

СОДЕРЖАНИЕ ОТЧЕТА 

Отчет должен быть подготовлен в соответствии с шаблоном 

(Приложение 1) и содержать таблицы с измеренными расстояниями между 

Элис Спрингс и Атлантой, а также Лос-Анджелесом и Нью-Йорком для 

всех указанных проекций, а также получившиеся карты США и Санкт-

Петербурга. 

ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 

1. Что такое датум? 

2. Что такое картографическая проекция? 

3. Какие типы картографических проекций вы знаете? 

4. Назовите три наиболее известные проекции. В чем их 

преимущества? 

ЛИТЕРАТУРА 
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3. Бугаевский Л. М. Математическая картография: Учебник для 
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Лабораторная работа № 3 

 Отображение пространственных данных 

ЦЕЛЬ РАБОТЫ 

В ходе данной работы студенты научатся работать с географически 

привязанной информацией и получат навыки создания двумерной 

визуализации данных с использованием ГИС. 

ОБОРУДОВАНИЕ И ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ 

Для выполнения данной лабораторной работы требуется: 

— QGIS Desktop 2.16 и выше; 

— браузер с доступом к сети Интернет; 

— текстовый редактор. 

КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Картографическая визуализация обладает следующими 

характеристиками: 

— преимущественная двухмерность; 

— статичность;  

— постоянные масштаб и уровень детализации. 

ГИС часто используются как средство автоматического построения 

карт, в таком случае все критерии и требования картографии используются 

и в ГИС. Анаморфозы — это производные слои от карт, визуальное 

представление которых изменяется в соответствии с данными на исходной 

карте. В англоязычной науке синонимом термина анаморфоза являются 

transformed maps, cartograms. Анаморфированные изображения 

подразделяются на линейные (графы), площадные (в которых площадь 

объекта зависит от значения некоторого показателя), объемные.  

Широко распространённым способом визуального представления 

данных является использование количественных и качественных фонов. 

Данный процесс тесно сопряжен с районированием, а окраска 

осуществляется в соответствии с некоторой шкалой. Районирование может 

осуществляться с использованием информации о каких-либо параметрах 

объекта, с помощью специальных равномерных и неравномерных сеток 

или методов деления пространства. 

Диаграмма Вороного (названа в честь российского ученого Георгия 

Вороного) представляет собой специальное разбиение плоскости. В 

результате разбиения пространства диаграммой Вороного по данным будет 

визуализирован набор областей, каждая из которых содержит ровно одну 

точку. 
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Тепловая карта (heatmap) – это способ представления данных, при 

котором значение интересующей переменной отображается цветом.  

ХОД РАБОТЫ 

Добавление тайловых карт. В сети Интернет существует 

множество источников карт, которые также могут быть добавлены в QGIS. 

Посмотрим, как осуществляется импортирование не встроенных по 

умолчанию тайловых карт на примере сервиса Mapbox 

(https://www.mapbox.com/).  

Для начала создайте там бесплатный аккаунт и получите ключ 

(token key – доступен в профиле пользователя). Подготовьте файл для 

импорта данных, с этой целью в любом текстовом редакторе создайте 

текстовый файл типа Tabbed Separated Values (*.tsv) и сохраните его в 

локальной директории. Данный файл должен содержать следующую 

строку: 

Mapbox Mapbox 

http://api.tiles.mapbox.com/v4/mapbox.light/{z}/{x}/{y}.png?access_token=<your access token> 

Обратите внимание! Необходимо убедиться, что все слова 

разделены с помощью символа табуляции. Прямое копирование строки 

приведет к неверному результату. Также необходимо заменить фразу в 

угловых скобках на ваш ключ. 

 

Сохраните и закройте файл. Приведенная выше ссылка позволит 

загрузить определенную подложку. Изучите сайт компании, чтобы узнать, 

какие еще карты доступны. 

Для добавления карт в QGIS Desktop понадобится расширение 

TileLayer, установите его с помощью менеджера плагинов. После 

установки плагин будет доступен через меню Web → TileLayerPlugin → 

Add Tile Layer… 

Перейдите в окно свойств (Settings) и укажите путь к папке, в 

которой хранится подготовленный файл TSV (рис. 3.1). 

 
Рисунок 3.1 – Окно настроек плагина TileLayer 

https://www.mapbox.com/
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Выберите ваш слой Mapbox и нажмите кнопку «Add» (добавить) в 

соответствии с рис. 3.2. 

 
Рисунок 3.2 – Окно интерфейса плагина TileLayer 

Обратите внимание! Все последующие действия требуют создания 

новых слоев, убедитесь, что вы сохранили их в соответствующей 

директории с корректным именем. Это существенно упростит процесс 

работы. 

 

Подготовка данных с помощью BBBike. Для выгрузки данных с 

использованием сервиса BBBike (рис. 3.3) необходимо выполнить 

следующие действия. 

1. Переместить карту к интересуемой локации. 

2. Создать ограничительный полигон. 

3. Изменить или переместить полигон, если необходимо. 

4. Установить формат экспорта Shapefile (Esri). 

5. Нажать на кнопку экспорта «Extract». 

6. Скачать готовые данные на компьютер. 

 

Рисунок 3.3 – Интерфейс сервиса BBBike 



28 

 

Обратите внимание! Если ссылку на выгрузку данных утеряна или 

письмо не пришло, посетите страницу со списком последних заказов в 

системе: https://download.bbbike.org/osm/extract/. 

 

Гексагональная сетка. Добавьте в проект данные о точках 

интереса (слой point), выберите из них только данные, относящиеся к кафе 

(type = ‘café’). Для построения сеток понадобится плагин MMQGIS, в 

случае отсутствия установите его. Создайте слой сетки Hexagon Grid Layer, 

используя меню Create. Убедитесь, что проекции сетки и исходных данных 

о галереях совпадают, в противном случае создайте слой вновь. 

Теперь подсчитайте, сколько точек попадает в полигон, для этого 

воспользуйтесь инструментом анализа векторных данных: Vector → 

Analysis Tool → Points in polygon (либо Processing Toolbox → Vector 

Analysis Tool и вызовите двойным кликом функцию Count points in 

polygon). 

Отфильтруйте полигоны, которые не содержат точек, с помощью 

инструмента Select features, условие NUMPOINTS > 0. Теперь сохраните 

выделенные полигоны на новый слой. Настройте стили для слоя с 

полигонами (рис. 3.4). 

 

Рисунок 3.4 – Гексагональная сетка 

Тепловые карты. Изучим плотность застройки в Санкт-

Петербурге. Для этого откройте в QGIS слой buildings и извлеките 

центроиды из каждого полигона с помощью команды Polygon centroids в 

меню Toolbox. После этого перейдите в меню Raster → Heatmap → 

Heatmap. 

Обратите внимание! Если данное меню отсутствует, следует 

активировать плагин Heatmap через окно плагинов. 

https://download.bbbike.org/osm/extract/
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В окне стилей установите тип рендеринга на Singleband pseudocolor 

и выберите палитру. Для получения результата, как на рис. 3.5, установите 

способ классификации Quantile, а в качестве режима смешивания Burn (в 

дополнение к этому можно варьировать настройки прозрачности – 

Transperency). 

 

Рисунок 3.5 – Тепловая карта 

Другой способ создать теплокарту – это использовать сетку 

регулярных точек. Убедитесь, что проекция проекта совпадает с проекцией 

слоя с домиками. После этого вызовите в меню функцию создания 

регулярной сетки аналогично предыдущему пункту (либо используйте 

Vector -> Research Tools -> Regular points).  

Диаграмма Вороного. Изучим плотность остановок общественного 

транспорта в городе. Для этого выберите остановки из слоя points. Для 

создания диаграммы выберите в основном меню пункт Vector → Geometry 

Tools → Voronoi polygons (либо MMQGIS → Create → Voronoi diagram). 

Получившаяся диаграмма будет выглядеть, как на рис. 3.6 с точностью до 

цвета. 
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Рисунок 3.6 – Диаграмма Вороного 

Для того чтобы изображение было более информативным, окрасьте 

полигоны в зависимости от их площади (установите в поле Column 

значение Geometry → $area, рисунок 3.7). 

  
Рисунок 3.7 – Диаграмма Вороного с настроенными стилями 

Подготовка изображения для печати. QGIS Desktop позволяет 

подготовить карты в соответствии с требованиями печати. Импортируйте 

файл TripAdvisor.csv в проект с помощью функции “Add Delimited Text 

Layer”, проекция слоя WGS 84 (4326). В качестве проекции проекта для 

печатной карты установите Pseudo Mercator (EPSG 3857). Отключите 

предыдущие слои (рис. 3.8). 
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Рисунок 3.8 – Данные о точках интереса из TripAdvisor 

Отфильтруйте данные по какому-либо параметру. Используйте для 

представления данных одну из вышеописанных техник: диаграмму 

Вороного, тепловые карты или гексагональные сетки. Теперь можно 

готовить карту для печати, для этого в основном меню перейдите в Project | 

New Print Composer. Интерфейс окна подготовки изображения представлен 

на рис. 3.9. 

 
Рисунок 3.9 – Интерфейс окна Print Composer 

Приложение Print Composer предназначено для подготовки карт, 

http://www.qgis.org/en/docs/user_manual/print_composer/print_composer.html.  

http://www.qgis.org/en/docs/user_manual/print_composer/print_composer.html
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Установите горизонтальную ориентацию (Landscape) и задайте 

разрешение 350 DPI (является требованием для высокого качества печати). 

Используя кнопку «Add new map button», нарисуйте прямоугольник в 

любой области листа, где вы хотите разместить карты. Однако следует 

учесть, что карта должна содержать заголовок и легенду. Размер карты 

можно изменить после создания. 

Обратите внимание! В общем случае карта отображает ровно ту 

же область, что отображена в QGIS Desktop. Если необходимо переместить 

карту или изменить ее масштаб, перейдите в QGIS Desktop и выполните 

требующиеся действия, после этого вернитесь Print Composer и 

воспользуйтесь кнопкой «Refresh view».  

 

Для добавления заголовка воспользуйтесь инструментом Add new 

label. Отображаемый текст задается в окне Item Properties. Для настройки 

свойств заголовка, выберите текстовый слой во вкладке Items. В окне 

свойств (рис. 3.10) можно настроить размер шрифта, выравнивание и 

многое другое. Сделайте заголовок по центру карты. 

 

  
Рисунок 3.10 – Добавление заголовка 

Для добавления легенды используется инструмент Add new legend. 

Поместите легенду в правой части карты аналогично предыдущим слоям. 

Настройка отображения легенды также регулируется через окно свойств. В 

первую очередь выключите автообновление легенды Auto update. Данная 

операция позволит редактировать элементы легенды в окне подготовки 

печати, однако изменения карты в интерфейсе QGIS Desktop не будут 

влиять на легенду. 
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По завершении сохраните получившуюся карту в высоком 

разрешении, для этого воспользуйтесь кнопкой экспорта «Export as image». 

СОДЕРЖАНИЕ ОТЧЕТА 

Отчет должен быть подготовлен в соответствии с шаблоном 

(Приложение 1) и содержать диаграмму Вороного, тепловую карту, 

гексагональную сетку, а также подготовленную для печати карту с 

заголовком и легендой. 

ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 

1. Является ли визуализация необходимым атрибутом 

картографического изображения?  

2. Какими преимуществами обладают электронные атласы в 

сравнении с бумажными картами? 

3. Не заменят ли (в перспективе полностью) бумажные атласы 

их электронные аналоги? 

4. Какие способы районирования пространства использовались 

в данной работе? Какой способ вы считаете наиболее 

эффективным? 
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Лабораторная работа № 4 

Создание векторных данных в QGIS Desktop 

ЦЕЛЬ РАБОТЫ 

В ходе данной работы студенты получат знания о необходимых 

исходных данных для получения географически привязанной информации, 

научатся производить обработку и преобразование данных в ГИС. 

ОБОРУДОВАНИЕ И ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ 

Для выполнения данной лабораторной работы требуется QGIS 

Desktop 2.16 и выше. 

КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Векторное представление данных – способ представления 

точечных, линейных и полигональных пространственных объектов в виде 

набора координат с описанием их геометрии. 

Растровым представлением данных является такое представление 

пространственных объектов в виде равномерной мелкой сетки, при 

котором каждому пикселу (ячейке растра) ставится в соответствие 

некоторое значение.  

Векторно-растровое преобразование (растеризация) – это процесс 

конвертации векторного представления данных в растровое изображение. 

Элементам растра (пикселам) при этом присваивается некоторое значение 

векторного объекта. Примером такого преобразования могут являться 

тепловые карты.  

Растрово-векторное преобразование данных (векторизация) – 

процесс преобразования растрового представления данных в векторное с 

помощью набора заранее определенных операций. Обычно осуществляется 

автоматически или полуавтоматически. Однако автоматическое 

преобразование часто требует дополнительной корректировки 

специалистом.  

ХОД РАБОТЫ 

Добавление данных. В качестве источника для создания 

векторных данных можно использовать уже существующие карты, 

спутниковые снимки, аэрофотоснимки, а также схемы и чертежи. Однако в 

рамках данной работы будет использован проект плана строительства, а 

также спутниковые снимки, предоставленные сервисом Google.  

Подгрузите в проект пример очереди строительства – 2-

stage.geojson. Исходные данные являются неполными, часть зданий 

представлена только в виде изображения без географических координат. 
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Исправить это можно при помощи функции привязки растра (Raster -> 

Georeferencer). В окне добавления растра откройте изображение 2-stage.png 

Выберите ту же проекцию, что указана в проекте и запомните ее. С 

помощью инструмента Add Point добавьте точки привязки (их можно 

указать на карте), после этого вызовите окно сохранения (Start 

Georeferencing) и укажите название файла, папку и соответствующую 

систему координат. Вызовите эту команду еще раз – в папке должен 

появиться соответствующий tif-файл, содержащий информацию о 

координатах. Добавьте получившийся файл в проект (рисунок 4.1).  

 

Рисунок 4.1 – Результат привязки растра 

Создание нового слоя. Для создания нового набора данных 

необходимо задать слой, в который будут сохраняться созданные 

элементы. С этой целью создайте векторный слой с помощью окна New 

Vector Layer (рис. 4.2); для того чтобы перейти в данное окно, 

воспользуйтесь меню Layer → New → New Shapefile Layer. 

 
Рисунок 4.2 – Окно создания слоя 
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На данном этапе необходимо определить тип создаваемых данных: 

точки, линии или полигоны, поскольку каждый тип задается 

определенным образом и поменять тип данных для этого слоя в 

дальнейшем будет нельзя. В рамках лабораторной работы № 4 мы будем 

работать с полигонами, поэтому в окне создания слоя укажите тип 

полигон. 

Далее следует определить систему координат. По умолчанию QGIS 

Desktop использует ту же систему координат, что у всего проекта, поэтому 

данное значение можно оставить. В области списка атрибутов можно 

добавить необходимые поля для нового набора данных. По умолчанию 

каждый набор данных должен состоять из элементов, обладающих 

уникальным идентификатором – поле «id». Добавьте дополнительное поле 

с названием элемента, заполнив окно как на рис. 4.3. 

 
Рисунок 4.3 – Создание нового поля 

Определите директорию, куда необходимо сохранить 

получившийся шейп-файл, и задайте ему название. Новый слой 

автоматически добавится в проект. 

Добавление данных. В качестве источника для создания 

векторных данных можно использовать уже существующие карты, 

спутниковые снимки, аэрофотоснимки, а также схемы и чертежи. В данной 

работе будут использоваться спутниковые снимки, предоставленные 

сервисом Google. Добавьте растровый слой с картой, используя плагин 

OpenLayers, результат должен выглядеть, как на рис. 4.4. 

 
Рисунок 4.4 – Спутниковые снимки Санкт-Петербурга 



37 

 

Для создания новых векторных элементов необходимо перейти в 

режим редактирования данных. Режим редактирования включается и 

выключается для каждого слоя отдельно. Выделите слой на панели слоев, 

который необходимо отредактировать, и включите кнопку редактирования 

«Toggle Editing» . 

Обратите внимание! Если в панели инструментов отсутствует 

данная кнопка, убедитесь, что панель Digitizing активна. Для этого 

перейдите в меню управления панелями инструментов: View → Toolbars 

→ Digitizing. 

 

Как только режим редактирования будет включен, инструменты на 

панели станут активными. 

Далее перечислены основные инструменты в порядке их 

расположения на панели слева направо: 

— Сохранение изменений. Сохраняет все изменения в текущем 

слое; 

— Добавление элемента. Запускает процесс создания нового 

элемента; 

— Перемещение элемента. Позволяет переместить выделенный 

элемент; 

— Инструмент вершин. Позволяет переместить и 

взаимодействовать с частью элемента – вершиной полигона; 

— Удалить. Удаляет выделенный элемент; 

— Вырезать. Осуществляет удаление элемента с копированием 

его в буфер обмена; 

— Копировать. Осуществляет копирование элемента со всеми 

свойствами; 

— Вставить. Осуществляет вставку элемента из буфера обмена. 

После выбора инструмента Добавление элемента курсор мыши 

примет вид перекрестия. Это позволит более точно разместить точки, 

которые будут оцифровываться. Помните, что даже когда используется 

инструмент оцифровки, можно увеличивать и уменьшать масштаб карты, 

вращая колесо мыши, и можно перемещаться, удерживая колесико мыши и 

перетаскивая мышью по карте. 

Для создания объекта нажмите левой кнопкой мыши на точку на 

углу здания. Разместите точки таким образом, чтобы область заливки 

полностью совпадала с контуром здания. После размещения последней 

точки щелкните правой кнопкой мыши, чтобы закончить рисование 

полигона. По завершении откроется диалог, в котором необходимо 

заполнить значения полей (идентификатор и название). 

Обратите внимание! Если в процессе создания была допущена 

ошибка, объект всегда может быть отредактирован по окончании создания. 

http://docs.qgis.org/2.14/en/_images/edit.png
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Редактирование существующих объектов. Для редактирования 

ранее созданных элементов выберите инструмент Select Single Feature, как 

показано на рис. 4.5. 

 
Рисунок 4.5 – Инструмент выделения объектов 

Для редактирования элементов доступны следующие инструменты: 

— Перемещение объектов; 

— Инструмент вершин; 

— Удаление выделенного; 

— элемент меню Edit → Undo либо комбинация клавиш Ctrl+Z 

для отмены последнего действия. 

Добавьте в проект слой с административными районами Санкт-

Петербурга, в данном слое озера и мелкие реки не являются частью 

районов. Исправьте полигоны, используя инструмент вершин (Node Tool). 

Переместите вершины, относящиеся к озеру, так, чтобы они совпадали, 

либо воспользуйтесь инструментом удаления. Исправленный участок 

города представлен на рис. 4.6. 

 
Рисунок 4.6 – Полигон, представляющий район после коррекции 

Если у полигона вырезаны некоторые части, дополнить его можно с 

помощью инструмента изменения формы (Reshape Features) . Изучите 

принципы работы данного инструмента на примере района Автово 

(рис. 4.7). 

http://docs.qgis.org/2.14/en/_images/mActionReshape.png
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Рисунок 4.7 – Район Автово до редактирования 

Кликните левой кнопкой мыши внутри области выделенного 

полигона, для того чтобы начать редактирование. Нарисуйте полигон, 

содержащий три угла, так (в форме буквы П), чтобы последняя точка 

находилась внутри полигона. Кликните правой кнопкой мыши для 

завершения построений. На рис. 4.8 представлен исправленный полигон. 

 
Рисунок 4.8 – Район Автово после редактирования 

Используя тот же инструмент, можно вырезать части полигона. Для 

этого начните построение фигуры снаружи редактируемого полигона, 

нарисуйте фигуру, которую хотите вырезать. Затем щелкните правой 

кнопкой вне редактируемого полигона для завершения. Результат 

использования данной техники представлен на рис. 4.9. 
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Рисунок 4.9 – Отредактированный район Автово  

Для того чтобы разделить один полигон на несколько частей, 

используется инструмент разделения (Split Features) , чтобы отделить 

часть в отдельный полигон, сохранив всю информацию. Воспользуйтесь 

данным инструментом для разделения рек. Нажмите левой кнопкой мыши 

на существующую вершину, затем кликните на вершину на 

противоположной стороне, полигон будет разрезан по получившейся 

прямой.  

Воспользуйтесь инструментом выделения, для того чтобы 

убедиться, что новый полигон создан. Полигон будет подсвечен, как на 

рис. 4.10. 

 
Рисунок 4.10 – Новый полигон  

СОДЕРЖАНИЕ ОТЧЕТА 

Отчет должен быть подготовлен в соответствии с шаблоном 

(Приложение 1) и содержать следующие изображения: исправленный 

любой район города без озер и мелких рек, исправленный район Автово, 

изображение реки, разделенной на полигоны. 

Также отчет должен содержать карту со слоем, содержащим 

минимум 20 полигонов, соответствующих местам в Санкт-Петербурге. Для 

http://docs.qgis.org/2.14/en/_images/mActionSplitFeatures.png
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этого данные необходимо подготовить самостоятельно, каждый элемент 

слоя должен содержать поле с названием. В отчете необходимо разместить 

подготовленную карту с легендой, названием и подписями всех мест.  

ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 

1. Для чего нужны преобразования между типами данных? 

2. Почему после растрово-векторного преобразования 

необходимо проверять получившееся изображение? 

3. Какой тип преобразования осуществлялся в этой работе? А в 

предыдущей? 

4. Какие операции над векторными данными использовались в 

рамках данной работы? 

ЛИТЕРАТУРА 

1. Берлянт А. М. Картография: Учебник для вузов. М.: Аспект 

Пресс, 2002. 336 с., С. 259-278 

2. Берлянт А. М. Теория геоизображений. М.: Геос, 2006. 262 с., 

С. 124-188 

3. Берлянт А. М., Кошкарев А. В. Геоинформатика. Толковый 

словарь терминов. М.: ГИС-Ассоциация, 1999. 205 с. 
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Лабораторная работа № 5 

Базовые операции над векторными слоями 

ЦЕЛЬ РАБОТЫ 

В ходе данной работы студенты получат навыки работы с 

программным обеспечением для визуализации географически привязанной 

информации; навыки работы со слоями электронных карт, освоят способы 

получения, обработки географически привязанной информации, 

представленной в векторном виде. 

ОБОРУДОВАНИЕ И ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ 

Для выполнения данной лабораторной работы требуется QGIS 

Desktop 2.16 и выше. 

КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Векторные данные могут быть представлены на карте в виде точки, 

линии или полигона. 

Современные графические редакторы в общем случае позволяют 

совершать следующие действия над векторными объектами: 

— вращение; 

— перемещение; 

— отражение; 

— растягивание; 

— аффинные преобразования над объектами. 

Более сложные булевы операции над векторными данными: 

объединение, дополнение, пересечение и т.д. 

QGIS Desktop позволяет совершать эти, а также многие другие 

операции над векторными объектами. 

ХОД РАБОТЫ 

Для выполнения данной работы распакуйте архив и запустите файл 

проекта. 

Обрезка. Удаление части данных с использованием границ другого 

слоя. 

Для выполнения этой операции перейдите в меню Vector и 

выберите функцию Clip (рис. 5.1). 
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Рисунок 5.1 – Меню Vector 

В качестве исходного выбирается слой, который необходимо 

отредактировать (Rivers and Streams), в качестве границ используется слой 

с границами города (City Limits). Определите адрес директории, в которой 

хотите сохранить файл, и задайте его название (например, CS Rivers.shp). 

Поставьте галочку напротив пункта Open output file after running algorithm 

(таким образом, после вычислений слой добавится в проект 

автоматически) и запустите процесс. 

Обрезка с вычитанием. Удаление данных внутри некоторой 

области.  

Аналогично предыдущему пункту перейдите в меню обработки 

векторных данных (Geoprocessing Tools) и выберите инструмент 

Difference. В качестве входных данных используйте слой с границами 

страны (Brazos County Boundary), а в качестве границ, по которым следует 

обрезать, выберите слой, отвечающий за город (City Limits). Определите 

папку и название результирующего файла. По завершении процесса 

исследуйте результат. 

Пространственное объединение. Аналогично базам данных 

различные пространственные слои можно объединять, основываясь на 

географическом положении. Используйте меню (рис. 5.2) для доступа к 

функциям редактирования данных Data Management Tools, в перечне 

выберите объединение по местоположению (Join attributes by location). 
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Рисунок 5.2 – Меню управления данными 

В качестве целевого используется слой, в который необходимо 

добавить данные (Rivers and Streams), источником данных выступает слой, 

откуда будет добавлена информация (City_Limits). Все остальные 

настройки сохраняются по умолчанию. Добавьте полученный слой в 

проект. Для нового слоя в таблице атрибутов будут объединены свойства 

обоих слоев. 

Самостоятельно изучите, в чем состоит различие между разными 

типами объединений – пересечение, касание и т.д. (intersection, crosses). 

Добавление геометрической информации в таблицу атрибутов. 

В процессе работы иногда необходимо изменить систему координат и 

проекций, при этом, как известно из лабораторной работы № 2, в 

зависимости от типа проекции некоторые геометрические свойства, такие 

как длина или площадь, могут не сохраниться. По этой причине 

целесообразно хранить эти значения вместе с остальной информацией.  

Для добавления информации выделите слой с реками (Rivers and 

Streams) в панели слоев. Воспользуйтесь меню управления векторными 

данными, перейдите во вкладку Geometry Tools и выберите инструмент 

Export/Add geometry columns. Выберите слой рек и установите параметр 

Calculate using = Layer CRS (вычисления будут выполнены для текущей 

системы координат проекта). По завершении вычислений в таблице 

атрибутов добавится новое поле, соответствующее длине линий, LENGTH. 

СОДЕРЖАНИЕ ОТЧЕТА 

Отчет должен быть подготовлен в соответствии с шаблоном 

(Приложение 1) и содержать следующие снимки приложения: результат 

выполнения операций «обрезка», «обрезка с вычитанием», 

«пространственное объединение», а также снимок обновленной таблицы. 
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Самостоятельно подготовьте карту любого района или 

ограниченной территории (например, острова) Санкт-Петербурга, 

используя материалы к лабораторной работе. Карта должна содержать 

только границы выбранного района и находящиеся в нем здания. В 

дополнение к этому здания, отвечающие каким-либо условиям, например, 

только музеи, должны быть визуально отделимы (воспользуйтесь 

параметром contains). Итоговая карта должна содержать легенду и 

название. 

ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 

1. Какие операции над векторными данными вы знаете? 

2. Какие преобразования выполнялись в рамках данной 

лабораторной работы? А в рамках работы № 4? 

3. Можно ли выполнять подобные операции над растровыми 

данными? Если да, то каким образом? 

ЛИТЕРАТУРА 

1. Брынь М. Я., Богомолова Е. С., Коугия В. А., Левин Б. А. 

Инженерная геодезия и геоинформатика. Краткий курс. СПб: 

Лань, 2015. 288 с., С. 449-485 

2. Берлянт А. М. Картография: Учебник для вузов. М.: Аспект 

Пресс, 2002. 336 с., С. 238-259  

3. Берлянт А. М. Теория геоизображений. М.: Геос, 2006. 262 с., 

С. 188-202 

4. Геоинформатика: Учеб. для студ. вузов / Е. Г. Капралов, А. В. 

Кошкарев, В. С. Тикунов и др.; Под ред. В. С. Тикунова. М.: 

Издательский центр «Академия», 2005. 480 с., С. 396-430 
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Лабораторная работа №6 

Создание трехмерных карт 

ЦЕЛЬ РАБОТЫ 

В ходе данной работе студенты получат навыки работы с 

программным обеспечением для визуализации географически привязанной 

информации; навыками работы с видами слоёв электронных карт, узнают 

способы получения, обработки географически привязанной информации, 

представленной в векторном виде. 

ОБОРУДОВАНИЕ И ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ 

Для выполнения данной лабораторной работы требуется следующее 

программное обеспечение: 

— QGIS Desktop 2.16 и выше; 

— браузер с доступом к сети Интернет. 

КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ 

Рельеф – это важнейший и главный элемент ландшафта. Данные о 

рельефе преимущественно хранятся в растровом формате в виде спутников 

фотоснимков с информацией о высотности. 

DEM (digital elevation model) – представляет собой цифровую 

модель поверхности рельефа.  

Наличие дополнительного измерения в рамках трехмерной 

визуализации позволяет более эффективно представлять данные, имеющие 

несколько параметров в рамках одной карты. Однако при использовании 

объемных визуализаций следует учесть особенности рельефа изучаемой 

области, либо отказаться от отображения рельефных особенностей 

территории. 

ХОД РАБОТЫ 

Получение данных о рельефе. Одним из источников данных о 

рельефе является ресурс USGS EarthExplorer (рисунок 6.1), который 

предоставляет информацию для исследований бесплатно. В случае если у 

вас нет аккаунта на данном ресурсе – зарегистрируйтесь. 

Для получения DEM файла перейдите на сайт EarthExplorer 

(http://earthexplorer.usgs.gov) и выберите интересующую вас область. Для 

отображения данного формата через QGIS Desktop понадобится плагин 

QGIS2Threejs. Установите его, если необходимо. 

 

http://earthexplorer.usgs.gov/
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Рисунок 6.1 – Интерфес EarthExplorer 

Создание трехмерной визуализации. Откройте QGIS и 

импортируйте ваш DEM файл. Как известно, файлы данного формата 

содержат геопривязку, тем не менее добавление слоя с картой упростит 

работу с проектом. 

Запустите плагин QGIS2threejs (Рисунок 6.2). Поскольку рельеф 

Санкт-Петербурга и Ленинградской области не содержит резких 

перепадов, усилим разницу искусственно с помощью параметра vertical 

exaggeration во вкладке World. Положим его равным 100. 

 
Рисунок 6.2 – Интерфейс плагина QGIS2threejs 

Убедитесь, что во вкладке DEM в качестве источника данных указан 

ваш файл с рельефом, в качестве отображаемого слоя (параметр – Display 

type) укажите слой со спутниковой картой. Запустите процесс создания 
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карты по кнопке «Run», после этого откроется браузер с изображением 

близким к представленному на рисунке 6.3. 

 
Рисунок 6.3 – Результат работы плагина 

Отображение данных в трехмерном виде. QGIS2threejs позволяет 

не только создавать карты рельефа, но и отображать данные в трехмерном 

виде. Добавьте набор данных в проект (например, из открытых 

источников, либо из предыдущих лабораторных работ). Для настройки 

отображения внешнего вида перейдите во вкладку Point (или Polygons в 

случае полигональных данных, рисунок 6.4). 

 
Рисунок 6.4 – Окно настройки отображения данных 

Установите значение “base height” – 0. Базовая высота 

соответствует величине отклонения объектов от трехмерной карты. 

Запустите трехмерную визуализацию. Повторите данную операцию для 

линейных и полигональных данных. Пример результата для точек 

представлен на рисунке 6.5.  
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Рисунок 6.5 – Результат работы плагина 

СОДЕРЖАНИЕ ОТЧЕТА 

Отчет должен быть подготовлен в соответствии с шаблоном 

(Приложение 1) и содержать следующие снимки браузера: трехмерную 

карту с рельефом, карты с трехмерными данными всех типов. 

Самостоятельно подготовьте трехмерную карту любого района или 

ограниченной территории (например, острова) в городе Санкт-Петербурге, 

используя материалы предыдущих лабораторных работ. Полученная веб 

страница должна быть запакована и приложена к отчету. В отчете должны 

содержаться снимки экрана с данной картой. 

ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 

1. Что такое DEM формат? Что будет если открыть файл такого 

формата в графическом редакторе? 

2. В чем преимущества и недостатки трехмерной визуализации 

данных? 

3. В каких случаях использование трехмерной визуализации 

является целесообразным? Приведите не менее трех 

примеров. 

ЛИТЕРАТУРА 
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Инженерная геодезия и геоинформатика. Краткий курс. СПб: 

Лань, 2015. 288 с. 

2. Берлянт А. М. Картография: Учебник для вузов. М.: Аспект 
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Кошкарев, В. С. Тикунов и др.; Под ред. В. С. Тикунова. М.: 

Издательский центр «Академия», 2005. 480 с. 
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Приложение 1 

Форма титульного листа отчета о выполнении лабораторной 

работы 
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Миссия Университета – открывать возможности для гармоничного 

развития конкурентоспособной личности и вдохновлять на решение 

глобальных задач.  

 

 

КАФЕДРА ВЫСОКОПРОИЗВОДИТЕЛЬНЫХ ВЫЧИСЛЕНИЙ 

Кафедра высокопроизводительных вычислений (ВПВ) создана в 

2010 году на факультете Информационных технологий и 

программирования (ФИТиП). Преподавательский коллектив кафедры ВПВ 

состоит из специалистов в области математического и компьютерного 

моделирования, обработки сверхбольших объемов данных, научной 

визуализации и виртуальной реальности и предметных областей. 

 

Сотрудники кафедры принимают активное участие в реальных 

научных проектах мирового уровня и публикуют результаты исследований 

в ведущих российских и международных журналах. Собственная 

современная лаборатория, оснащенная уникальным оборудованием, 

вычислительными ресурсами и облачными сервисами, позволяет в режиме 

реального времени решать широкий спектр задач в области 

компьютерного моделирования, управления большими объемами данных, 

создания ситуационных центров для принятия решений и координации 

работ в условиях чрезвычайных ситуаций, а также 3D-визуализации 

исследуемых процессов и результатов экспериментов. 

 

Кафедра высокопроизводительных вычислений получила 

сертификаты о международной и профессионально-общественной 

аккредитации магистерских образовательных программ от European 

Network for Accreditation of Engineering Education и Ассоциации 

инженерного образования России. 

 



 

 

 

 

 

 

 

 

 

 

 

 

Мухина Ксения Дмитриевна 

Билятдинова Анна Закировна 

Карсаков Андрей Сергеевич 
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Городская информатика и геоинформатика.  

Учебно-методическое пособие по выполнению  

лабораторных работ  
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